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€ suacesystems

1. Preparing QGIS
» Downloading QGIS
» Installing QGIS
» Setting up QGIS

2. Data downloading
» MADAS
v’ Downloading ASTER data
» EarthExplore
v’ Downloading Landsat 8 and DEM data
» Copernicus Open Access Hub
v Downloading Sentile-1 and Sentinel-2 data
» GADM
v'Downloading administrative border data (vector data)
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Downloading QGIS @spaaawems

® Search “QGIS”.

' New Tab X + - 0
C G Search Google or type a URL  + B B O O N @ :

Bookmarks

Gmall Images &% @

Google

© QGIS

{=

Z Customize
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Downloading QGIS @spacasysfems
® Open “Welcome to the QGIS project!” link.

' G qqis - Google Search X +
< C & google.com/search?q=qqis8ioq=QGIS&aqs=chrome 0.3513912j0i457j0I5.74877j0j15&sourceid=chrome.. % + B Wl © O N G
Google agis X & Q
Q All &) Images [&] Videos [E News Q Maps ! More Settings  Tools

About 4 880,000 resuits {0.49 seconds)

qgis.org ~
Welcome to the QGIS project!

ree and Open Source

¢ Information System.
Download QGIS  Discover QGIS « Changelog for QGIS 3.16 + Documentation ?

en.wikipedia.org » wiki : QGIS ~
QGIS - Wikipedia

QGIS is a free and open-source cross-platform desktop geographic information system (GIS)

application that supports viewing, editing, and analysis of .. QGIS
Written In: C++, Python, Qt Stable release: 3,16.0 "Hannover" (Octobe...
Platform: Windows, Linux, Mac OS X, Androi... Initial release: July 2002

QGIS is a free and open-sol

e o _ desktop geographic informa
ja.wikipedia.org » wiki » QGIS ~ Translate this page that supports viewing, editin
QGIS - 'j’f :F/\T’f p 2 geospatial data, Wikipedia

14 h o~ ' iy A Uy THR AL AT v | e DD T AR/

-
T L T

»
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Downloading QGIS @spacesysfems

® Scroll down and open “Download Now” link.

l Q) Welcome 10 the QGIS project!
-

C & qgisorg/en/site/ w 4+ & B (ST ‘ :

DISCOVER QGIS FOR USERS GET INVOLVED DOCUMENTATION

QGIS

A Free and OPJ MmO syl
s C & qgisorg/en/site/ w 4+ & B (ST ‘ :

-

DISCOVER QGIS FOR USERS GET INVOLVED DOCUMENTATION —
11IQOo TTIH ITITAQOoOTWAl
New release: 3.16!
set the
For your deskiap, server, In your web browser and &
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Downloading QGIS @space.systems

® Scroll down and download QGIS installer.

» Choose installer of 64bit or 32 bit depend on your windows os from the “Long term
release repository”.

-

#& qgis.org/en/site/forusers/downdoad htrr w 4+ & B 0 *» 0 :

DISCOVER QGIS FOR USERS GET INVOLVED DOCUMENTATION

Download QGIS for your platform

Binary packages {instafers) are avallable from this page

The current version is QGES 3.16.1 'Hannover andll (3 Download QGiS

The long-term repositories currently offer QGIS 3.1 & C # qgis.org/en/site/foruser
QGIS is avalable on Windows, macOS, Linux and

DISCOVER QGIS FOR USERS GET INVOLVED DOCUMENTATION

" LATION DOWNLOADS L RELEA Standalone instalters from O5GeodW packages
Latest release (richest on fonturesy
Download forWinidows i Q QGIS Standalone Installer Version 3.16 (64 bit)

sha256

QGIS in OSGeodW:
/\ i Q QGIS Standalone installer Version 3.16 (32 bit)
i \*/ OSGeodW Network

sha256

Lang term rulsess repository (most stable)

4 \’\ QGIS Standalone Installer Version 3.10 (84 biy) o

shaz2s56
4 s QGIS Standalone Installer Version 3.10 (32 biy
\ N
sha256 -
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Downloading QGIS

® To confirm your windows, open properties of your PC with file explore.
> Click right mouse button on “This PC" and select “Properties”.

> See “system type”

File Computer View

e G Uninstall or change a program
v - -

A System propertjes

| Properties Open Renans Access Map network Add a netwark Open
\ medis*  drive * location Settings A Manage
oca H System
Click left mouse button to
« v (&) r This PC
open property of your PC
@ OneDrive L] Name Type Total Size Free Space
« Comtrol PaneAll Controf Pane! Hems'iSystem
I RO —— Folders (7)
| | * 9 Control Paned » All Control Paned ltems » System v D
Collapse 3 3D Objects ,
fHile Eda Yiew Jook
Manage B Desktop P
Coentrol Panel Hoe : - : i
Pin to Start ] = Documents o oo Pane Home View basic information about your computer
3 ‘ Downloads { @ Device Manager Windows edit
Map network drive. ' fnaaus edmen
i .I‘ Remote sethings
J\ Music \ e 9% Windaws 10 Pro

Open in new window

P .\
Sy !J System protection 2015 Mucrosoft Corporation. A% ngnts .- WI n d OWS 10

; ) = Pictures
Pin to Quick access : %) Advanced system settings reserved
; B videos )
Disconnect network drive
Devices and drives {1) System
Add a network location & Windows (C) Processar intelR] Core(TM) 17-65000 CPU @ 250GHz  Suppert Infarmation
259 GHz
Delete Network jocations (1) installed memory (RAM): 00 GB {7.87 G8 usable)
Rename - Shiba (\172.16.1 i System type 64-bit Operating System, »68-based processor
Pen and Touch Touch Support with 10 Touch Paints

( Properties )

9 items 1 item selected

Computer name, domain, and workgroup setings

Computer name ERS-307 & Crange setting
full computer name: ERS-307
Security and Mamtanance Computer descaption
Workaroup WORKGROUP =l
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Downloading QGIS

® QGIS installer is downloaded.

Manage Downloads

File Home Share View Application Tools a
1 & Cut x -J 1) New item ~ \/ ‘W Open - = Selectall
= W& Copy path * 5 ¥ | Easy access * Fdit Seledt pone
| pinti Quick Copy  Past Mowe  Copy Delete Rename New Propéerties
ICCOsS #l Paste shoricut 1o+ o . folder - & History Invert selection
Ulipboard Organize New Open lec
& - 4 ¥ > ThisPC > Downloads v O canrch Downloads
AgnRShandbook * [0 Name Date modified ype
Bor
Today (1}
CAO — e s .
V15 QGIS-05Ge0dW-3.16.1-1-Setup-x86_64.exe 11/29/2020 818 AM Applicati
Fieldspec
Yesterday (1)
) GRIAS ‘
work 1 8/2( 104 AM File folde
’ Panasonic
QGIS34
temp

* Documents
’ v & Downloads
work
D Music
= Pictures

B videos

® WWiemdAdeane (A

2 items 1 item selected 396 MB

{!
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Installing QGIS

® Install QGIS step by step.

1 'Hannover Setug

Welcome to the QGIS J 161
‘Hannover’ Setup Wizard

Thes woard wil Qude you Syouch the nstallaton of QGIS
3361 Mamover’

’.

N\
316

RELLEYG

1t s recoesmended St you dose Al other agpicabions
before staring Sehup, Thes wil make it possbie to update
relevant systen fles without havng to reboot your
comeNter

Chck Next to continue

Ohoore Domposants
Choose which features of QGIS 3.16. 1 Hannover' you mant to rstsl

Q@

Check the comporents you want 1o nstall and urcheck the canporents you dor't mant to
rtal. Ohck el 15 shar! the rataliaton,

Select cotponeras 1 matal = Descrpion
[] North Carcing Data Set
[} South Dakota (Spearfish)
[ Maics Omta Set
Soace regared: 1OGD
< »
<k | pwwt | | Cancel

Licence Agresment
Heate revew the bosnse terme defore nstsling QGIS 316, 1 Hanmover'

Instaling
Fieace wat side QGIS 316, 1 Hanrover' is berg nstaled

Ohoose Inctall Lacstion
Choose $e folder 0 which to nstal QGIS 3. 16. 1 Marmover’

Q@ Q@

Setm vl rwtal QIS 3, 16 1 Yormover' m S followng fSoider. To nstall n a $ferert folder,
cick Browee and ssiect ancer fokder, Olck Next 15 contirue

Press Page Doer 1o see the rest of the agreement,

Lcerse overvew;

1. Q@S

2. The HOFS ibrary for teading and wiiting HDFS format

3. S2IP compresson brary

4, The NetCDF r vy and commands for reading and seisng NetCOF format
S. ECW Raster Mugn for CDAL

6. The HOF 4 ibrary for reading and wiiting HDF4 format

7. Gracle Instart Chent

8, MESID Rawter Pugn for GOAL

f you acoept the S=rme of the agresment, dick [ Agree o continue. You must accept the
sgreement to retal QG5 ). 16, 1 Hernover’

T

Complating the QGIS 3161
‘Hannover’ Setup Wizard

QG5 3.15. 1 Harnover’ has been nataled on your
computer

Ok Firnsh 1 dose ths mzard

316

RELLEYG
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Installing QGIS @spacesysfems

® QGIS folder is created on your PC desktop.

R ER= C\Users\Public\Desktop\QGIS 3.16

» QGIS 3.16

W Quick access

by QGIS Desktop 3.16.1 with GRASS 7.8.4
@& OneDrive

= This PC
# 3D Objects

B Desktop

* Documents
¥ Downloads
J' Music
- Pictures
i Videos
&. Windows (C))
=x Shiba (\\172.16.1.10) (Z.)

# Network

I 1tem
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Installing QGIS

® Start QGIS.

. Untitled Progect — QGIS
Project Edit View Layer Settings Plugins Vector Raster Mesh Help

BREY B ssns GLaRaLEOR ° L=- “ T

<

- By,
Project Templates

Ready Coordirate % Scale 52245008 » i Magnifier 100%

s Fotaton 00 °

QGIS 3.10 Changelog now
available!

Do you want to ses all the amazing new
foatures and bug fixes that wers introduced
n 2GIS 3107 Double click this message to
ofen the viswual changelog in your browser
Qur visual changelogs provide & nice
cantralized list of af the key new features in
sech relesss. Each fasturs deacription is
usually sccompsnied by an imags or short
screan recording  Go QGE community. go!

|
|QGIS 3.10 Changelog now availablet|

Planned end of life for Windows
32-Bit Support v

New Empty Project

EPSG 4326 - WG5S 84

$ V Fender @BEPSGAE @
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Setting up QGIS spacesystems

® To change default settings, open options in Setting menu.

. Untitled Project — QGIS

BREk N User Profiles
L 14

v u’s Style Manager..
4 Custom Projections...

. . -
|
Lavers i Keyboard Shortcuts...
“« eV v T ' rf
. ce Customization
Interfa ustomizat v v Override System Locee o |~
3
ons :
“ OP" ons Jser intactsca tranulation B Armancen Engleh v
J\;‘ Systemn pome Inumbss, date and curmncy formats) Erglish LninadSiates lsn LS -
- V' Shaw group (thoisand) ssperstor o
&: CRS Note: Enabling / chenging cverrids on lcals requres sn spolcaton reptart =
"E bSO St Dateoted activie kooaks an your systam 0 US
Sample date 11/23/20 monsy $1.00000 int: 1.000 float 1 00000
- Data Sources T
» Application
Re o = -
b hoesing Styk (OGIS restact requied) Fusion v
Canvas & U theene (OGIS restart reguied) e failt - o
Legend lcon sze 24w
WA \vap Tools Fant o Ot dafaut * Sigeld © S Pt
f, Colors Timoout for tmed meszages or diafogs LT —
Hde =plesh scroan st startup
. Digitizing - . -
newa Med on walkome page
- Layokits V' Ohack OGIS version at startup
Uss native color choosar deiogs
@ GoaL
Modakess data soutce manager dakog
Y lere .
it i * Project Files
Q thanueatx Open project on launch Welcorme Page ¥
. Network
Lreate new proect from deleull propot
Locator e i . v
Cat MNavemat Duninar e Mndaiiv Do Madaain
(o] Carosl Halp

Acceleration

Brawser Layers
Reasdy Coordirate % Scale 52245008 w | g Magnifiar 100% s Fotaton 00 ° s V Render QEF’SG 4326 '
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Setting up QGIS

® For example, you can change language at General tab.

BN American English .
-l
* vV Override System Locale = GuArapcKu -
- ’
A\ General User intarface translation Bd bosanski
2 acale ( bers, date and fi | .U,
@ SySIGm Loca numobers, date a8 CUImeEncy ormats h CeS(ma
am dansk
= anging avernde on lboale requirg ®E Deutsch
L General tab ale on your system en LS = EAnvIKG
i /20 money $1,00000 int 1,000 E= espaﬁo| de Espana
Data Sources — 3
* Application o eesti
7 Renden . == euskara
AR Style (QGIS restart required) =
) Canvas & Ul thame (QGIS restart required) B francais
Legend lcon size ™\ galego
R Map Tools Font ® Ot default = Magyar
fslenska
F! Colors Tunsout for imed massages or dalogs 1 1 italiano
_ Hde splash screen at startup [ ® |
4 Digitizing H5) ST R ) r -
' : V' Show QGIS news feed on welocome pege o pt=0]
u Layouts Vv Check OGIS version at startup Bl koiproizua
Lise native color chooser dislogs = lietuviy
A GDAL , — .
HA' Modaless data source manager dialog latviesu
Variabias norsk bokmal
a * Project Files == Nederlands
a Authentatior QOpen progoct on launch Weloome Page ¥ polski
portugués
=T Network EN portugués europeu
Create naw projact from defaull project 3
Locator EH romana .
Cat Mt Ducinat we MNaba s Dot Makas s - pchK"“
Acceleration §d ++ sardu i
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Setting up QGIS

® For example, you can use proxy at Network tab.

~. Options — Network

General a
=
General Timeout for network requests (ms) 50000 -
J@ System Dafault expiration period for WMS capabilities (hours) 24 —~
=2 Default expiration period for WMS-C/WMTS tiles (hours) 24 -
& Crs i
Max retry in case of tile or feature request errors =

€3 o6
s anstormation

User-Agent Maozilla/5 0

i Data Sources Cache Settings

Q" Rendering

Content Authentioation

- Canvas & Directory

Legend ’
B Moo Tools Size [KiB) /51200 ¢ @
F! Colors > Use Proxy for Web Access
nDi(_)mng Jhamas B 1 SR e IR SRS ST SH P
‘ Layouts
% GOAL Dot bty

W General tab
l.. Network

Locator v

OK Cancsl Help

Acceleration g
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Preparing Data

® You should make folders to save data depend on its type.

» Raster or vector?
» ASTER, Landsat8, Sentinel-2, and so on.

BER = Downloa
File Home Share
Pin to Quick
4

access

Clipboard
*= ~ 4 ¥ > ThisPC

v & Downloads

Data

Raster
ASTER
Landsat8

Sentinell

Sentinel2

v Vector

DIVA

D Music

> = Pictures
; . Videos
» &+ Windows (C)

“Chikhas AVATY AC 4 ANV 1T

3 tems

ds

View 0
' } .
New item ~ =+ Select all
X v
Copy path ¥ | Easy access * Edit Select none
Delete Rename New Propéerties
u o o . folder . & History Invert selection
Organize New Open Select 1
> Downloads » v 9] rch Downloacd
2 Name Date modified ype
Today {2)
Data 11/29/2020 9:51 AM File folde
@ QGIS-0SGeodW-3.16.1-1-Setup-x86_64.exe 11/29/2020 918 AM Applicati
Yesterday (1)
work 11/28/2020 10:04 AM Fi
v < >
-

@space.systems
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Preparing Data @space.systems

® Search 7zip.

» Some downloaded data is compressed, so that you need to decompress them
before analyzing.

' New Tab X + = 8
C G Search Google or type a URL w + B H O 0O N @ :

Bookmarks

Gmall Images  ii: @

Google

=

Z Customize
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Preparing Data

® Open link of 7zip web site.

' G J:Ip A Gcogif i %

& - C @& googlecom/search?q=7zip8iogq=Tzip&ags=chrome. 63i57j0I3j0i10013.35704j0j158sourceid=chrome&ii... %+ B Wl © O B @ :

Google 7zip X & Q

Q Al &) Images [ Videos & News [ Books i More Settings  Tools

About 8,760,000 resuits {0.51 seconds)

atures of 7-Zip. High compression ratio in 7z format with LZMA and LZMA2 7_Z|p <

compression; Supported formats: Packing / unpacking: 7z, XZ, BZIP2, ...
Downloadable software

Download 7z Format
Download .exe, 64-bit x64, 7-Zip 7z Format - is the new archive
for 64-bit Windows x64 (Intel ... format, providing high ...

7-Zip is a free and open-soL

More results from 7-zip.org » used to place groups of files

containers known as "archiv

sevenzip.osdn.jp ~ Translate this page Igor Paviov and was first rel
Elﬁg 2 ﬁgl ¥ ) |\ 7-Z|p its own 7z archive format, b
[EH8 - WY 7 -7-Zipld. 7z, ZIP. RAR. LZH. ISO. TAR, DMG. MSIZE. &35 several other archive format
—Z DA =W FC1DTHIGL TOSHBEICF D777 D ...

License: LGPLv2.1+ with u
SDK in the public domain  ~
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Preparing Data @spacesﬁems

® Download 7zip.
» Select downloader depend on your windows os.

' 7-Zip x e : 03
< C & T7-ziporg “ + B H O O N @ :

7-Zip 7-Zip 20.02 2020-08-08
ZIP . | | 7-21p 20.02 alohs
7-Zip is a file a - a=laglcompression ratio.

fnload 7-Zip 19.00 (2019-02-21) for Wint 7-Zip for
Home ARM64 2020-08-08
7z Format Link Type Windows 7-Zip for ARME4
LZMA SDK
32-bit x86
Download . 7-Zip 20.00 2020-02-06
FAQ 64-bit x64 7-Zip 20.00 alpha
Support
Links N 7-Zip 19.00 2019-02-21
0-08-08) for Windows:
7-Zip 19.00
English Link Type Windows Size
m’ i +
Ch:zese Trad. Download .exe 32-bit x86 1.2 MB
7- Chan
Esperanto Download  .exe 64-bit x64 1.4 MB b Shengeton
Erench History of 7-zip changes
German Download  .exe 64-bit ARM64 1.5 M8
]
e License
Portugyese Brazil
Spanish 7-Zip is free software with open source. The most of the code is under the GNU LGPL
mﬂ license, Some parts of the code are under the BSD 3-clause License. Also there is unRAR license
Vietnamese restriction for some parts of the code. Read 7-Zip License information.

You can use 7-Zip on any computer, including a computer in a commercial organization. You
don't need to register or pay for 7-Zip.

The main features of 7-Zin
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Preparing Data

® Install 7zip.

Manage

Downloads

File Home Share

’ I B Preview pane

View Application Tools

@l Extra large icons &= Large icons

e
ae Medlum lcons 353 Small [cons

Group by =

1 Add columns =

l N';‘\-‘j‘;l]':l".o" N Dt pane ey = Detells - .:J:’: 111 Size all columns to fit
} Panes Layout Current view
& ~ 4 ¥ > ThisPC > Downloads
W This PC * O Name
- 3D Objects Today (3)
B Desktop Data
Desktop (i@ 721900-x64 exe
* Documents @. QGIS-05Ge04AW-3.16.1-1-Setup-x86_64.exe
¥ Dovinloads Yesterday (1)
Data work
work
D Music
= Pictures
W videos

£ Windows (C)
=x Shiba (\\172.16.1.10) (Z:)

W Network v
1 item selected 1.37 M8

4 items

[¥! iem check boxes
V! File name extensions
H
| Hidden items

Show/Mhide

Search

Date modified

11/29/2020 9:51

11/29/2020 10:54

7-Zip 19.00 (x64) Setup

Destination foldar

T ogram Files¥]

Zip¥

I Install

Cancel|

Destination foldar

S ¥Program Files¥7~ZinY

1-2ip 1900 (x64) is installed
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L ) suacesystes

® Search MADAS.

' New Tab X + : 0
C G Search Google or type a URL w + B H O 0O N @ :

Bookmarks

Gmall Images : @

Google

©® MADAS

{=

Z Customize

“Event” in month, year 20 (12020 Japan Space Systems



@spacm?ems
® Open link of “MADAS (METI AIST Data Archive System) web site.

' G MADAS - Google Search X + : 0
« C @ googlecom/search?q=MADAS&0q=MADAS&aqs=chrome 0 69i59i0/46110120/46(1012011022073i0j15.. % + B W © O » @ :
Google MADAS X & Q
QAN B mages Q Maps ([0 Videos B News § More Settings  Tools

About 2,550,000 resuits {0.54 seconds)

.gsj.jp» madas ) map v

MADAS(METI AIST Data Archive System)

MADAS(MET! AIST Data Archive System). Search Scene. Sort Old
R (Dec 18, 1999 - Current), JERS-1 '

¥ Search Reset, Satellite
SensOr

gbank.gsj.jp » madas ~

MADAS - AIST

Mar 26, 2020 — TOP; = View MADAS; = About MADAS; = Data List; = Quick Guide; =
History; = FAQ. Terms of Use. = Disclaimer; = Terms of Use.

www.madas.it » azienda ~

Company profile - Madas S.r.l.

Madas is working with almost all the countries in the world where the gas is used. The continuos
research together with even more performing and competive ...
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L ) soacesysts

® MADAS is opened.

' G MADAS(METI AIST Data Archiy x + — ) X

O » @

P

< C & gbank.gsjjp/madas/map/indexhtn 2 o 3

Sort Old '@ New Search | Reset
Satellite Sensors
€4 2sTER  (Dec 18, 1999 - Current)

Observation Period

From 2019-11-29 00:00:00 To 2020-11-29 00:00:00 (UTC
Search Aree degree ®' Decimal Sexagasimal
N
v E
<

Granule ID

e.g. ASTB151220013331

Operational Mode ® Al VST T ST
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L ) soacesysts

® Set period you want to download data.

If you want to use SWIR, you have to set period before 2007.

C & gbank.gs)jp/madas/map/index.htm w + 5 QO R @ :

0 [ 2019 v

rad) e ey

su mo e we m = s« MADAS(METI AIST Data Archive System)

+

= o} X

=
-nnﬂml:l:
el 10] 11] 12] 13] 1a] 15
EEEEIEE
SO 1| 25| 2] 27] 2]
Satellite < Time
00:00:00
-‘-S"’ Hour .
Observatio ™ “:e.
From “‘:mc’. 2020-11-29 00:00:00 (UTC
Search Are @ Now | m gesimal
N
; Select date
Granule ID
g. ASTB1 1

Operational Mode ® Al VST T ST

-
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® Set area you want to download data.

' G MADASIMET! AIST Data Archwy X + == lj X
(_

C # gbank.gs)jp/madas/map/index.htm w 4+ B QO R @

Sort Old '@ New Search | Reset
Satellite Sensors
B4 asTER (Dec 18, 1998 - Current)

Observation Period

From 2019-11-29 00:00:00 Te 2020-:1-29 00:00:00 (UTC)
Search Arsa degres @ Dacimal Sexagesimal
N 35.6530
W 138.4034 E 113%9.0461

Granule ID

e.g. ASTB15122001333¢

Operational Mode @ Al VST v T ST
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L ) soacesysts

® Set additional criteria.
> You should select Day as “Day or Night” and 0 as “Cloud Coverage %",

® Click Search button.

'GHA SIMET! AIST Data Archwy X +

(& & gbankgshpl vadas/map/index.htm w + B ' QO R @

Cbhservation Period

From 2019-11-29 00:00:00 To 2020-11-29 00:00:00 (UTC)
Search Area degree ® Decimal Sexagesimal
N 35,6530
W 1384034 E [139.0461

S | 35.0762

Granule ID

e.g, ASTB151220013331

Operational Mode ® all VST v T ST

Day or Night Both ® pay Night

Hlumination Elevation Angle From To deg.
Cloud Coverage = Yo

Pointing Angle From T deg. (-25 to 25)

¥ Search Results & Download

Back to the TOP

National Institute of Acvanced Industnal Science and Technology (AIST)

Background Image source: Blue Martie Next Generation by NASA

“Event” in month, year 25 12020 Japan Space Systems



L ) soacesysts

® The list of results is displayed in left side.
> If you have no results, try to change cloud coverage or period.

' G MADASIMET! AIST Data Archwy X + == lj X
& O » @

»

C # gbank.gs)jp/madas/map/index.htm w

MADAS(METI AIST Data Archive System)

BN~

3 results 1V

GranulelD: ASTB200514013933 Overlay
AcquisitionDate: 2020-05-14T01:39:282

Metadata | Tar | Kmi
GranulelD: ASTB200320013408 Overiay
AcquisitionDate: 2020-03-20T01:34:032

Metadata | Tar | Kmi
GranulelD: ASTB200320013359 Overlay
AcquisitionDate: 2020-03-20T01:33:542

Metadata | Tar | Kmi

-
jo ot Aduancas ndictieal Selonce and Tachaalem: (AISY
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L ) soacesysts

® In order to check metadata such as Granule ID, Satellite Sensors and so

on, click “Metadata” button.

' .G MADASIMET! AIST Data Archwy X +

< C & gbankgsjjp/madas/map/index.htm

MADAS(METI AIST Data

R
&

[t B o catitee S rranebancior AN —~ —

3 results 1V

Metadata button

200514013933
ate: 2020-05-14T01:39:282
Tar | Kmi

Overiay

Metadata
GranulelD: ASTB200320013408
AcquisitionDate: 2020-03-20T01:34:032

Metadata | Tar | Kmi

QOveriay

. 55 ,,!

GranulelD: ASTB200320013359
AcquisitionDate: 2020-03-20T01:33:542
Metadata | Tar Kmi

QOveriay

Granule ID
Satellite Sensors
Observation Period

Obsarvation Area

Sun Ilumination Elevation
Angle (deg.)

Cloud Coverage (%)
Flying Direction

Operation mode

Pointing Angle(deg.)

Vnir Pointing Angle(deg.)
Swir Pointing Angle(deg.)
Tir Pointing Angle(deg.)

VNIR

SWIR

TIR

= s X

O » @

% 4+ & W

Metadats

ASTB200514013933
ASTER
2020-05-14T01:39:282

[139.111341,35.951096]
[139.792735,35.847388]
[139.625547,35.295003]
[135.948749,35.397937]

i7 2334 , 35 6645

68.739075

0.0
DESCENDING
VST

5.674
5.674

mrtenaleen: QST
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L ) soacesysts

® In order to check preview image, check “Overlay” option.

' G MADASIMET! AIST Data Archwy X + == lj X
(_

<

C & gbankgsjjp/madas/map/index.htm w + B (o I @

MADAS(METI AIST Data Archive System)

3 results 1v Overlay bUttOn

GranulelD: ASTB200514013933 YO«.'QFAV

AcquisitionDate: 2020-05-14T01:39:282
Metadata | Tar | Kmi

£

s

‘e
GranulelD: AST8200320013408 Overiay
AcquisitionDate: 2020-03-20T01:34:032
Metadata | Tar | Kmi

GranulelD: ASTB200320013359 Overiay
AcquisitionDate: 2020-03-20T01:33:542
Metadata | Tar | Kmi

Adatbnral inctih o of Aduancos indictngl Saloneg and Tortunalem: QST
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® In order to download data, click Tar button.

' G MADAS(MET! AIST Data Archwy X + s ol X
& C & gbankgsjjp/madas/map/index.htm * + & B (S @

M gbank.gsj.jp says

7
;
E
;
A
-
B
L
3
L
3
D,
.
(N

Tar button

= GranulelD: A
Q'. AcquisitionDa
l* Metadata

GranulelD: ASTB200320013408 I TOveray
AcquisitionDate: 2020-03-20T01:34:032
Metadata | Tar | Kmi

00514013933
2020-05-14T01:39

r | Kmi

GranulelD: ASTB200320013359 Overiay
AcquisitionDate: 2020-03-20T01:33:542
Metadata TJar Kmi

Algtinnal Inciih dg ot Aduancas indectegl Srloneg and Tortnalym

“Event” in month, year 29 12020 Japan Space Systems



® Move downloaded file to ASTER folder.

BER = Downloads

File Home Share View
B Preview pane @l Extra large icons = Large icons Group by *
sa Medlum lcons :_: Small icons - l Add columns =
| Navigation Detai < L 3t s
‘ pane * B Details pane List = Details - by * Size all columns to fit
Panes Layout Current view
&« « 4 ¥ » ThisPC » Downloads » v
’ ¥ Dowinloads * O Name
Data
Today (4)
Raster
Data
-
ASTER \ @ 721900-x64 exe
Landsat8 /@) ASTB200514013933 tar bz2
Sentinel () QGI5-05GeodW-2.16.1-1-Setup-x86_64.exe
Sentinel2 Yesterday (1)
Vector work
GADM
work
D Music
& Pictures
. Videos

<. Windows (C))
cChikhae AMVATY AC 1 ANV I

5 items 1 item selected 38.7 M8

[¥! iem check boxes

v! File name extensions

r
9

Options

ype
Fi 06
pplicati
BZ2 File
Applicany
Fil e
>
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® Extract tar.bz2 file here.
» Click right mouse button on your downloaded file.

CAUsers\ERS-307\Downioads\Data\Rasten ASTER

B Enzm
File Hame Share View
& Cur
U= Copy path
Cegy
Clinboard
Open

B share with Skype
$ 00 Shace with Skyps
D & Meve to OneDrive

W'ZIE

CRC SHA
*  GeoSetter
& Share
A P 8 U
Open with
w Give access to
4 Md Restore previous versions
= Pic Sond to
B vid
Cut
Wi
Copy
wx Shi
Create shortcut
1 item Delete

e

Move

o

v

X -] .'

Copy  Delete Femame  New
to - - foider
Organize New
Raster » ASTER
5 aamns
FAMBE ASTRINNG 14N 13972 tar hrd
Open archive
Open archive
Extract files
Extract Here
mmsmwm.
Test archive
Add to archive
Compress and email..
Add to "ASTB200514013933 tar
Compress to *"ASTB20051401 )9’
Add to "ASTB200514013923 tarf
Comipress to "ASTB2005140139

Neéww llem =

- )

[Bz] Cpen =

Easy ac(ess *

Properties
- » Histary

e

Home

o Cut

W Copy patt

Crpw

Clipboard

§ Downlosds
Data
Raster
ASTER
Landsatd
Sentinell
Sentinel2
Vector
work
D Music
&~ Pictures
. Videos
2. Windaws (C:)

wx Shiba (\172.16.1.10) (Z)

2 items 1 tem selected 135 MB

View

» This PC » Downloads

H Setect all
Select none
et selection

Select

e

Moo
o

-~

Extract

Copy

Campressed Folder Tuols

2 ] :

Drlite

o= v

Now
toidor

Forame

Ohrganire

» Data » Raster » ASTER

Name

B ASTR200574073933 tar
ASTE200514013933 1arh22

Nesw item =

Easy &ciess

New

CAUsers\ERS- T\ Downloads\Data\Raste\ASTER

Select all

Edopen - H

fy Select hone

v

Properties

v » Histary brvert selection

Select

[
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® Extract tar file here.
> Click left mouse button on your expressed file.

View

& Cue

U= Copy path

Copry
Clinboard
~ Open
B Share with Skyps
$ 00 Shace with Skyps
D & Meve to OneDrive
‘ ?rltg
| CRC SHA
*  GeoSetter
& Share
P DR G e U 2
Open with
w Give access to
4 Md Restore previous versions
= Pic Sond to
B vid
Cut
Wi
Copy
wx Shi
Create shortcut
2 items Delete

Extract

e
Mowe
o5

>
>
>
>
>
>
>

Campressed folder Jools

X -] .'

Copy  Delete Femame  New
to - - foider
Organize New
Raster » ASTER
5 aamns
(AMBE ASTRINNG 14013973 1ar
Open archive
Open archive
Extract files
Extract Here
mmsmmm
Test archive
Add to archive
Compress and email..
Add to "ASTB200514013933 2
Compress to *"ASTB20051401 )9’
Add to "ASTB200514013923 2.4
Comipress to "ASTB2005140139

Neéww llem =

Easy ac(ess *

CAUsers\ERS- XN\ Downloads\Data\RasteASTER

@) Cpen = selectall

Select none
Properties

- » Histary et selechion
e sefect
v 4] carch ASTES
R B = CAUsers\ERS-307\Downioads\Data\Rasten ASTER
Flle Home Share View
!
* & Cut x - ]
W Cogy pat - '
Finw Quice  Crgy o Move Copy Dty Rersime Now
C005S . : to~ to* v foidor
Cliptsoard hganixe
- v, ¢ » This PC » Downloads » Data » Raster » ASTER
§ Downlosds & MName
Data
3 M 2005140139332005159014
Raster ASTE200514013933 1ar
ASTER ASTB200514013933 tar bz2
Landsatd
Sentinell
Sentinel2
Vector
work
D Music

&~ Pictures
. Videos
2. Windaws (C:)

wx Shiba (\172.16.1.10) (Z)

3 items 1 tem selected

Nesw item =

Easy &ciess

New

Select all

s Open = {

‘/.
fy Select hone
Properties

v » Histary brvert selection

Select

[
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L ) suacesystes

® Satellite images are extracted.

Manage

CAUsers\ERS-30\Downloads\Data\Raster\ASTER\20051401393320

Hidle

termn
e

oCle

Search 20051401393

e Home Share View Picture Tools
r' B Preview pane B8 Extra large icons &= Large icons ] Group by ~ i¥| ttem check boxes
- S5 Medium icons 255 Small icons v f colu » || File name extensions
Navigation a 3 ; sSon
p:{e .L ¥ Details pane List Details . b Size alt columins to Tit Hidden items
Panes Layout Current view Show/hide
« v 4 Downloads » Data » Raster » ASTER » 2005140139332005159014 v L
v & Downloads i datal.3a.demsh ¥ datat 3a.vnirt tif
v Data e data1 13a.demzs tif ¥e data 13a vnir2 tif VNIR
v Raster datal.l3a.gh *data‘l,l.’,a.vnidn.tif
v | ASTER ¥ datatidaswirdtift ) BB datall3avnirsh
2005140139332005159014 % data 13a swirs.1f
Vaackiatn *data1.l3a.swir6.tif
andsa =
*data1 13a.swir7 tif TI R
tinell
Sentine *data].lSa‘swirB.tif
Sentmei2 ¥= data1 3a.swirdtif
4 Vector datal.l3a.swirsh
GADM ¥ datat3atiniOtif )
ok ¥z data1 (3a.tirt 1. tif
. ¥edatar szt B SWIR
. ¥z data1.13a.tir1 3 if
& Pictures
B vid ¥ datat Batinatii |
ideos :
Y datal.l3a.tirsh
2 WA mae I
20 items

Options

32005

=
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Earth explore @spacasﬂems

® Search earth explore.

' New Tab X + 2 0
2> C G Search Google or type a URL w + B H O 0O N @ :

Bookmarks

Gmall Images : @

=

Z Customize
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Earth explore

® Open link of EarthExplore web site.

' G earth explorer - Google Search X + g J

< C & googlecom/search?q=earth+explorer&oq=Earth+exploref&ags=chrome.0.69i59j69i57j0i20i263j015.246.. ¥+ + B W © O » @ :
Go gle earth explorer X $§& Q
Q All &) Images @ Maps (3] Videos (3 News : More Settings Tools

About 179,000,000 results (0.48 seconds)

earthexplorer.usgs.gov

EarthExplorer

Query and order satellits

ages, aerial photographs, and cartographic products through the
U.S. Geological Survey
EROS Registration System - Select Data Set - Perform a Search

You've visited this page many times, Last visit: 11/14/20

People also ask

How do you use the Earth Explorer? v
Where can | find the most up to date satellite images? v
How do | register for USGS Earth Explorer? v
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Earth explore

@spacesys'tems
® EarthExplore is opened.

® Click Login button to create new account.

' EE EarthExplorer X +

< C # earthexplorer.usgs.gov

= USGS

science for a changing world

Login button
EarthExplorer

1. Enter Search Criteria

To narrow your search area: type In an address or place name,
enter coordinates or click the map to define your search area (for
advanced map tools, view the help documentation), and/or
choose a date range.

Search Criteria Summary (Show) Clear Search Criteria
Willm ar

& 3 Mimeagoli s
KML/Shapefile Upload T »

Select a Geocoding Method
Feature (GNIS)

Search Limits: The search result limit is 100 records; select a
Country, Feature Class, and/or Feature Type to reduce your
chances of exceeding this limit

World Features

Albert Lea

Feature Name

1se % as wildcard)

“Event” in month, year

36 (12020 Japan Space Systems



Earth explore @spacesystems

® C(lick “Create New Account” button.

' & EROS Registration System o + — o X
(_

C & erscrusgs.gov/iogin oo @ % 4+ & B O R @ :
W 4 -

forgot password?

Sign In

Don't haye an account?

Create New Account

OMB number 1028-0719
OMB expiration date 08/31/2021

Privacy and Paperwork Reduction Act statements: 16 U.S.C. Ta7 authorized collection of this information. This information will be used by the U.S.
Geological Survey to better serve the public. The time required to complete this information collection is estimated to average 2 minutes per response. We
will not distribute responses associated with you as an individual. We ask you for some basic organizational and contact information to help us interpret
the results and, if needed, to contact you for clarification. Comments on this collection should be sent to custserv@usgs.gov.

DOI Privacy Policy | Legal | Accessibility | Site Map | Contact USGS

U.S. Department of the Interior | DOI Inspector General | White House | E-gov | No FearAcl | FOIA
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Earth explore @space.systems

® Enter username, new password, and so on.
» USGS will send you an e-mail about account.

' @ EROS Registration System x +
C @& erscrusgs.gov/register o Q % + & @A QO R @

a USGS

science for a changing workd

EROS Registration System

Registration and login credentials are required to access all system features and download data from USGS EROS web services, To ensure privacy and security, ERS uses Hypertext Transfer
Protocol with Secure Sockets Layer (HTTPS) to encrypt user authentication

To register, please create a username and password. The information gathered from the registration process is not distributed to other organizations and is only used to determine trends in

data usage. Review USGS Privacy Policies

The Cancel button can be used to exit the registration process at any time and information entered will be lost.

Username ;
Username Requnrements
* Must be between 4 and 30 characters
* May contain alphabetic and numeric characters
New Password * May only contain the following special characters
o period"."
@ o atsign "@"
underscore " "
Confirm New Password dash "-*
=5 -
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Earth explore @space.systems

® After creating new account, click login button and sign in EarthExplore.

' & EROS Registration System X +

&« =2 C & erscrusgsgov/iogin o % + & B O B @

= USGS

science for a changing world

EROS Registration System

ERS consolidates user prIDﬁIe and authentication for all EROS web services into a sir;ngvié mdependent apphéétiéh.
Sign In

sign in with your extsting USGS registerad username and password

Takeda-Tomomi@)|spacesystems.of

....... @

forgot

forgot password?
Sign In

Don't have an account?

Create New Account

-
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Earth explore @spacesysfems

® Select world features.
® Enter city name and click show button.
® Select place name and show the location on the map.

' EE EarnthExplorer

¢« -2 C @& earthexplorer.usgs.gov e O R @

1. Enter Search Criteria

To narrow your search area: type in an address ar place name,
enter coordinates or click the map to define your search area (for
advanced map 1o0is, view the help decumentation ), and/or
choose a date range

KML/Shapefils Upload

Select a Geocoding Method
Faature (GNIS) v

Search Limits: The search resuit (imit is 100 records. select a
Country, Festure Class, andior Feature Type o reduce your
chances of axceeding this Aimit

\US Faahsrs

Featura Name

Tokyo
Country
All 1
Fealure Class C Ity n a m e
Al
Feature Type
Al
Chick on a4 Fealure 10 show the locastion on Ihe map and add coordngtes
10 the Area of Interest Control

Placename Type P I ace nhame holtude

1500

»
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Earth explore

® Pin icon is plotted on map.
» Coordinate is automatically entered.

' EE EarthExploter X +

¢« =2 C & earthexplorer.usgs.gov

1. Enter Search Criteria

To narrow your search area: type in an address or place name
enter coordinates or click the map to define your search area (for
advanced map 10085, view the help doecumaentation ), andlor
choose a date range

KNUShapetie Upioad

Select a Geocoding Meathod
Faature (GNIS) v
Search Limits: The search resut imit Is 100 records, select a

Country, Festure Class, andicr Feature Type o reduce your
chances of exceeding this mit

IS Faahsnrs I Wanrkt Frunten

Rttt & ettt

Featura Name

Country

All v
Fealure Class

Al v
Feature Type

Al v

Cacle Predetned Area

| i
i antmiissnabasons Il e

1, Lat: 35° 41 06" N, Lon; 139°45° 05" E

m-m

Coordinate of Pin
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Earth explore

@spacamfems

® You can select area directly to click left mouse button at the locations on the

map.

' EE EanthExplorer

X

+

& = C & earthexplorer.usgs.gov

Select a Geocoding Meathod
Feature (GNIS)

Search Limits: The search result Imit is 100 records, select a
Country, Feature Ciass, and/or Feature Type (o reduce your

chances of exceeding this hmit

US Foawies BN

| Vo Pt |
Feature Name

State

All

Feature Type
All

m Clrcle Predefined Area

Yeagre s S0es 2 Decms

1. Lat: 35° 52' 26" N, Lon: 139°
2. Lat: 35° 53' 00" N, Lon: 139°
3. Lat 35" 32' 30" N, Lon: 140°
4. Lat: 35" 25' 41" N, Lon: 1307

5. Lat: 35° 36' 01" N, Lon: 139"

2I'11°E

57 40"E

02" 36" E

48' 56" E

23 04"E

[ e ey

KosHiga ya
Sdilama

O7A W . : Mat suco
Kawagudh

ichikawea
.

TOK YO e un abasht

> o
hiba

Ichihara
.

Kayvasaki

Yokohama

Lzaliel | Thes © £511 — Sourre: Esn loubed USDA, USGE AEX GenEye Gemmapping. Aemgnd 15N, I1GP, UPR.ECE and the GIS User Coommunity, EBRIL

The provided mapa are not for purchase or for downtoad; it is 0 be used as a guide for reforance and search purposes only,
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Earth explore

® Set period you want to download data.

' EE EarthExplorer x +

<« - C & earthexplorer.usgs.gov a w 4 & B! O R @

CUL, | RS IS, WU 1 BOMNE 4 I ST U
chances of exceeding this Kmit

Koshigays

ey &m’mﬁ'ﬂ'ﬁi Saitama’ *
Feature Name fokar ozm vy o) T S Mat wudo
State = ] .V'h." awi
All v M arrs TOKYO o » funabashi
Feature Type ' Chiba

All

~
m m Kawasak Ichibara
B i‘l:‘:l: v ;z'i:‘ll vv
h.\;&\\Luae—mr;.-.\v.an
Su Mo Tw We ™ Fr Sa

Pradefined Area

{ 3 [

18

1. Lat: 35" 41° 06" N, Lon: 139" 45'0

Cloud Cover  Resut Optior Close

Search from: 11292019 {0
Search months: (a1 \ Ll | Ties © B4 —Sauee E50, heobed, USDA, USGS, AEX, GatEye, Getmapping, Aamgrdd, 10N 1GF, UFR-EGE. ant tha GIS U Conmmumity, ESR!

pe are not for purchase or for download, it is 1o be used as a guide for reference and search purposes only.

=
Click calendar
icon

Data Sets »

Ol Privacy Policy | Legal | Accessibilty | S

S Deparment of the Inferior | DOl Inspecior Genorst | While Houss | E.gov | No Fosr Act | FOIA
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Earth explore

® Select data set.

' EE EarthExplorer X +
&« > C & earthexplorer.usgs.gov Q %« + & B O R @ :
a USGS
i
science for a changing workd

EarthExplorer

Search Critena st Crt Res Search Criteria Summary (Snow Clear Search Criteria

2. Select Your [m‘\ Macbas

Check the boxes for the datd
done selecling data sel(s), ¢ b lak asak
buttons below. Click the plug Data set ta =
show a list of data sets

Use Data Set Prefilter (What's This?)

Data Set Search

Thiz dala set st s cached for performance. If your user
permissiona have changed Of you 3¢ Not Sesing &
expected dataset, chck hara 1D refresh your liss

S>aitama

+ Aerlal Imagery

' AVHRR ok Or 078 Wt - Mat suda
Kawag o .

+ CEOS Legacy

i o Ichikawa

¢ Commercial Satellites .

TOKYD e Lun abashi

* Declassified Data
+ Digttal Elevation

* Digital Line Graphs Sag N 'rm.-u a

+ Digétal Maps Kayasak:
* EO-1

* Global Fiductals

“Event” in month, year 44 12020 Japan Space Systems



Earth explore ¥/)spacesystems
® For example, select Landsat 8 OLI/TIRS C1 Level-1 data.

' EE EarthExplorer x +

& = C & earthexplorer.usgs.gov

GIBUOI 1 UL = =
+ HCMM
1 YA
Land Cover Kaw c;;'m- .
Landsat LJ Saitama
= Landsat Collection 1 ,"'j SFOIH W W 2 ch 1
+ Landsat Collection 1 Ljveld S Jehkawa
¥ Landsat C1 Analysis Repdy Data (ARD) A e
+ Landsat Collection 1 Lefel-2 {On-demand) oL ] 5
= Landsat Collection 1 Lejel-1 '
O K& & Landsd 8 OLITIRS C1 Lavel-1 a4
& Lancfat 7 ETH+ ©1 LovolT S
N Lysasat £.5 TM C1 Leveld
{andsat 1:5 MSS C1 Levei.1 Yokohama
¥ Landsst Legacy A e Fu isawa
£ LCMAP Odawara
+ NASA LPDAAC Collections Y
+ Radar
+ Sentinal
+ UAS
+ Vegetation Monitoring
+ 1SRO Resourcesat -
Addiional Criteria » Ludngl | Tiles 5 Evl —Sourte Sxt 10ted USDA USGS AEX. GeoFve Gatmappmg, Anregid IGN IGP UPR-EGE and tha G55 Usar Cammunity ESRI

The provided maps are not for purchase of for downioad: It 1s 10 be Used as & guide for refarence and nearch PUPoses only.

Privacy ¥ | Legal | Accessibdity | Site Map | C

S Department of the Intenor | DOI Inspector General | While House | Egov | No FearAct | FOIA
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Earth explore @spacesystems

® Set additional criteria.

' EE EarthExplorer X

<« 2> C # earthexplorer.usgs.gov

= USGS

science for a changing workd

EarthExplorer

Search Crtena BRI Additional Criteria

3. Additional Criteria (Optional)

If you have more than one data sets selected,
10 selact the addational critaria for each data sa

Data Sets
Landsat 8 OLIITIRS C1 Level-1 v

Landsat Product ldentifier
WRS Path

WRS Row

Land Cloud Cover

Scene Cloud Cover
Collection Category

Data Type Level-1

Sensor Identifier
Day/Night Indicator

Sun Elevation

Resurs

Additional
criteria tab

o]t
o]t
O]t
©]8)
©]e)
o]t
®F
o]t
O]t
OF

Search Criteria Summary (Snhow Clear Search Criteria

roshiga va
Sailama® *
.....
A Mat suda
Xawag o

° Ichikawa
.

TOKYD o [ unabashi

Sagamsara
.
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Earth explore @spacesystems

® Set additional criteria.

® You should select Day in Day/Night Indicator and Less than 10% in Land
Cloud Cover.

' EE EarthExplorer X +

& > C & earthexplorer.usgs.gov Q %« + & B O R @ :

a i

science for a changing workd

EarthExplorer

Search Crileia | Daa Sets Resuts Search Criteria Summary (Shew) Clear Search Criteria

3. Additional Criteria (Optional)

I you have more than one data sets sslected, use the dropdown
to select the adddional criteria for each data set.

Data Sals:
LandsatBQLUTIRS C1 Level1 v

Land Cloud Cover @
Less than 10% v

Scene Cloud Cover @

Saitama
Collection Category @ Mat sudo

Dawa ®

Kawagu i
Data Type Level-1 @ s Ichikawa
®OF 2 et o TOKY ) s furt abashi

Day/Night Indicator @
Sun Elevation (i) + v

»

“Event” in month, year 47 12020 Japan Space Systems



Earth explore

® The list of results is displayed in left side.

@space.systems

> If you have no results, try to change period or cloud coverage.

' EE EarthExplorer x +

&« -2 C @& earthexplorer.usgs.gov

r'/ ' =
science for a changing workd
EarthExplorer
Search Criteria  DataSets  Adabonal Critera m Search Criteria Summary (Shew) Clear Search Criteria
4. Search Results
Il you selocted mare than one data $61 1o search, usae the
dropdown to see the search results for each specific data set
Show Result Controls
Data Set ek he xpot you
Landsat 8 OLNTIRS C1 Level-1
1w
Displaying 1-50of §
1D: LCOB_L1TP_107035_20204123 20201123 _01_RT
Acquisition Date: 2020-11-23
Path: 107
Row: 35 Saitama
Yedd 7L HATO O 7R W A O3
10; LCO&_L1TP_107035_20200810_20200823 01 71
Acquisition Date: 2020-08-149
Path; 107
Row: 25
Yidd/LRAWES
1D: LCOB_L1TP_107035_20200429_ 20200509 01_T1
Acquisition Date: 2020.04.29
Path: 107 Kisara sy —
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Earth explore @spacesys‘tems

® In order to check metadata, click thumbnail image in the list.

'y +

¢« =2 C & earthexplorer.usgs.gov

Landsatiook Natural Color Preview Image

»

A A A A e A A A A i A A A A i A A A A o A A A A A o A A A A o A A A A A o A A A A A S A A A A A S A A A A A o A A A A A o A A A A A S A A A A A S A A e A A o A A b A A o A A A A A R A
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Earth explore @spacesysfems

® In order to check image coverage, click “Show Footprint” icon.

' EE EarthExplorer x +

& = C & earthexplorer.usgs.gov

-
4. Search Results
If you selected more than one data set 1o search, use the
dropdown to see the search results for each specific data sel
Show Result Controls
Data Set
Landsat 8 OLVTIRS C1 Level-1
1 v
Displaying 1 -50t 5
ID: LCDB_L1TP 1 .
aausienose] Show Footprint
Path: 107 Ueda Macbasyi
Row: . N
—— Matsumoto
1Dz LCO8 L1TP_107
Acquisition Date: 2
Path: 107
Row: 35
——11Ydd 7LHAWO
1D: LCO8_L1TP_107035 Q_20200503_01
Acquisition Date: 202(
Path: 107
Row: 35
’ od 72 6"7@ fuymomiya
Numazu
10; LCOB_L1TP_ 107035 20200312_20200325_01_71 2
Acquisition Date: 2020-03-12
Path: 107
Row: 15
Yedd 7L HNNO -
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Earth explore @spacesys‘tems

® [n order to check preview image, check “Show Browse Overlay” icon.

' EE EarthExploter X +

¢« =2 C & earthexplorer.usgs.gov

4. Search Results

f you selected more than one data 61 1o search, use the
dropdown to see the search results for each specific data sel

Show Result Controls

Data Set
Landsat 8 OLVTIRS C1 Level-1

1w

Displayin

ID: LCD8_L1TP_ 1070
| Acquisition Date.

Ueda Mach
. .

Matsumotlo
.

10z LCO8 L1TP_107%
Acquisition Date: 20/
Path: 107
Row: 35

VYedd /7LHAWO

ID: LCO8_L1TP_107035_ 20200428 20200503 01_T1
Acquisition Date: 2020-04-29
Path: 107
Row: 35 ’
Yedd JLEAWE fujmomiya

.
Numazu
10; LCOB_L1TP_ 107035 _20200312_20200325 01_11 L
Acquisition Date: 2020-03-12
Patn: 107
Row: 15 .;l nada

Yeid 7L HNWO EE* aancpwa -

Shizuoka
.
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Earth explore

® In order to download data, click “Download Options” icon.

® And click download button of “Level-1 GeoTIFF Data Product (xxx.xX
MiB)”.

' EE EarthExplorer X +

¢« -2 C @& earthexplorer.usgs.gov C + & B 0O R @ :

TR b a2 e MO LN

LangsatLook Naturai Color Image (7,46 MiB)
LangsatLook Thermal Image (1.85 MIB)
m LandsatLook Quality image (1,11 MIB)

Download Langsallook Images with Geographic Reference (10.42 Mi8)

l Dawnload Level.1 GeoTIFF Data Product (857.33 MIB)

Download
Options
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Earth explore

® Move downloaded file to Landsat8 folder.

Extract Downloads C

Compressed Folder Tools ®

Home Share View

¥ Preview pane W Extra large icons &= Large icons [ Group by * ¥ item check boxes

- e T '
ae Medlum lcons 353 Small [cons v 1 Add columns = ¥!| File name extensions

Navigation " Details pane = S0t Hide selected  Options

|
| List = Detalls = < - &t an Iter
\ pane = De by = Size all columns to fit Hidden items {tems -

Panes Layout Current view Show/Mhide
« « 4 ¥ > ThisPC > Downloads v b Search Dawnloads

’ ¥ Downloads * O Name

Data

ate modified Type

o

Today (5)
Raster -
Data 11/29/2020 951 AM File foide

ASTER
work

Landsat8 \ @ 721900-x64 exe

Sentinell {v]= LCO8_L1TP_107035 20201123 20201123 01 RT...
Sentinel2 (3} QGIS-05GeodW-3.16.1-1-Setup-x86_64.exe

Vector
GADM
work
D Music
& Pictures
. Videos
& Windows (C)

cChibha AVATI AC A ANV T

Sitems 1 item selected 857 MB -
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Earth explore

® Extract tar.gz file here.

Extract

Hame Share View

¥ Preview pane

—

25 Modiven kcons 188 Small &
Navigaton T Details pane List Details
pane = R =
Open
« B share with Skype

$ bo B Share with Skype }
& Move to OneDrive

740 D

Campressed folde

B Extra large xons &= Large lcans

CAUsers\ERS

f Jools

Gioup by =

HN\Downloads\Data\Raster\Lands

| ltem check boses

ons > § Acd columns = | File nama extensions
- Sort Hide selected  Optians
by - Sire all cokumns 1o 0 Hiadon Iterms Hems =
Current view Show/tude
Raster » Landsatd v 3] aarch Land
Mamé —
Extract

Open archive
Open archive
Extract files..
Extract Here
Extract to "LCO8 LYTP 107035 2
Test archive

Add 1o archive

Compress and email

Add to "LCO8_L1TP_107035_202
Compress to “LC0S_LITP_ 10703
Add to "LCO8_L1TP_107035_202
Compress to 'LCO&_L!TP_!O?OZ‘(

CRC SHA >
% GeoSetter >
LE? Share
B /- eravse >
Open with
Give access 1o >
Restore previous versons
w
DM Send to >
-~ Pic Cut
. Vic Copy
LW Create shortcut
i Deléte

1 item

Hame

View

Campressed Folder Tuols

RS-FHN\Downloa:

18\Raster\Landsats

¥ ltemn check boxes

r B Preview pane B8 Extra large kons &= Large lcans Sroup by -
22 Medivm kons B2 Small icons - 1 A colunns * v File name extansions .
"::itr:-'r' & Details pane List Detaits v :’:1 Sze all columins 1o 81 Hidden Items “d‘:l:":‘,m ) “":'r'
Panes yout Current view Show/hde
- v. ¢ » This PC » Downloads » Data » Raster » Landsatd v 3] irch Landsate
# Downloads & Mame Date modified Type
Sl R 1C08_L1TP_ 107035 20201123 20201123 01 R¥tar  11/23/72000 TAR File
Raster = LCOB_L1TP 107035 20201123 20201123 01 RTtargz 11/29/2020 203 P\ GZF
ASTER
Landsat8
Sentinell
Sentinel2
Vector
GADM
work
& Music
~ Pictures
. Videos
<. Windows [C)
Chibn AVETY 92 1 a2\ 5 ¢ 2
-~

2 items 1 tem selected 1,70 GB
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Earth explore
® Extract tar file to “LCO8_L1TP_107035_20201123_20201123_01_RT"

Hame Share View

¥ Preview pane

—

Navigaton

pane -

& Moediven ons

B Details pane List

Open
« a Share with Skype

$ b 8 Share with Skype
&  Mave 1o OneDrive

IZip
CRC SHA
% GeoSetter
le Share
P 7 Lo U S
Open with
Geve access to
w Restore previous versions
D Mu Send 10
-~ Pact Cut
B vid Copy
& Wi Create shortout
: Al Delete

B Extra large xons &= Large lcans

Extract

Campressed folder Jools

CAUsers\ERS- X\ Downloads\Data\Raster Landsats

1 item selected

@spacasystems

Gioup by = ! ltem check bosss
5 Small ioons - A calumns = ¥ Fie nama extensions
= Sort Hide selected  Optians
Detaihy - by - Size all cokimns 1o 0t Higdon lterms Hisine =
current view Show/tude
Raster » Landsatd v L&) =3 Lan
Mamé
R B = C\Users\ERS-307\Downloads\Data\Rasten\L andsats
b4 Open archive Flle Hame Share View Q
b
Open archive — W Exira large kons B Large lcans Group by * ¥ ltem check boses
S Extract files B Proview pane
22 Medivm kons B2 Small icons - 1 A colunns = vl File name extanslons
Navigation B pDetalls pane Sort Hde stlected  Optaing
M r,;.‘: -' Loy List Oetails p fy - Size all cohimins 1o Higden ilems “"‘"‘,. ; pe
? Extract to "LCOB_L1TP_107035
Panes yout Clurrent view Show/hde
2 Test archive
- v, ¢ » This PC » Downloads » Data » Raster » Landsat® v 3] irch Landsate
> Add to archwve
Compress and email § Downlosds & Name Date modified Type
Add to *LCOB_L1TP_107035_20: Data =% |
> j ; M LCOB_LITP 1070352020123 20201123 01 RY 11/2472020 3 File foldd
S P 1 . |
Compress to SLCOR.LTTP.1070; Raster B LCo8_L1TP 107035 20201123 20201123 01 RT tar 1/23/2020 3:50 PAA TAR File
Add to "LCO8_L1TP_107035_204 ASTER = LCOB_L1TP_107035_20201123_20201123_01_RY tarqz  11/29/2020 3013 P GZ |
Compress to *LCOB_L1TP_10703 Landsat8
Sentinell
Sentinel2
Vector
GADM
work
D Music
~ Pictures
. Videos
<. Windows [C)
v < ?
Chibn AVITY 32 Y v /9N
3 Items -~
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Earth explore

® Satellite images are extracted.
» Band number is included in file name.

@spacasysfems

Home

Share View

~

v & Downloads
v Data
v Raster
ASTER
v Landsat8
LCO8_L1TP_107035_20201123_20201
Sentinell
Sentinel2
v Vector
GADM
work
D Music
& Pictures

B videos

2 LT e Lt}

14 items

CA\Users\ERS-307\Downloads\Data\Raster\Landsat8\LCO8_L1TP_107035_20201123 20201123 01 _RT

& Lcos_L1TP_107035_20201123_20201123_01_RT_ANG.txt
¥ LC08_L1TP_107035_20201123_20201123_01_RIEDIIF
¥ 1C08_L1TP_107035_20201123_20201123_01_RT_B2.TIF
¥=1C08_L1TP_107035_20201123_20201123_01_RT_B3.TIF
¥ LCO8_L1TP_107035_20201123_20201123_01_RT_BA.TIF
#= .C08_L1TP_107035_20201123_20201123_01_RT_B5.TIF
#= C08_L1TP_107035_20201123_20201123_01_RT_B6.TIF
¥ LC08_L1TP_107035_20201123_20201123_01_RT_B7.TIF
#= 1C08_L1TP_107035_20201123_20201123_01_RT_B8.TIF
#=C08_L1TP_107035_20201123_20201123_01_RT_BO.TIF
¥ LCO8_L1TP_107035_20201123_20201123_01_RT_B10.TIF
¥= LCO8_L1TP_107035_20201123_20201123_01_RT_B11.TIF
¥ .C08_L1TP_107035_20201123_20201123_01_RT_BQA.TIF
B LCo8_L1TP_107035_20201123_20201123_01_RT_MTL.txt

. ] B Preview pane B8 Extra large icons &= Large icons ] Group by ~ i¥| ttem check boxes
- S5 Medium icons 255 Small icons v || Add columns = || File name extensions
Navigation ™ Details pane : ; Son Hide selected
pane : *pane List Details by = Size all columns to fit Hidden items ftBme
Panes Layout Current view Show/hide
« v P Raster > Landsat8 » LCO08_L1TP_107035_20201123_20201123_01_RT v L Search LCO8_L1TP_10

Options

Takeda Tomomi (Takeda-Tc

70135

|
0

-
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Earth explore

@spacem'tems
® Select area you want to download DEM data.

' EE EarthExploter X +

¢« =2 C & earthexplorer.usgs.gov

1. Enter Search Criteria

To narrow your search area: type in an address or place name
enter coordinates or click the map to define your search area (for
advanced map 10085, view the help doecumaentation ), andlor
choose a date range

KNUShapetie Upioad

Select a Geocoding Meathod
Faature (GNIS)

Search Limits: The search resut imit Is 100 records, select a
Country, Festure Class, and/or Feature Type o reduce your
chances of axceeding this Amit

] “ﬁ World features

Featura Name

IS Faahsnrs

Country
All 1 r $ Chiba
e City name : 8 R s
Fealure Class hy *Kawasaki
Al v
Feature Type
Al v
Show I Clear
Cacle Predetned Area
R i ===
LN tadssna b e .r«_lJ Snciivny
1, Lat: 35° 41° 06" N, Lon; 139° 45 05" E /R

(o ey ey
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Earth explore

® Don’t set period. Keep empty.

' EE EarthExplorer X

<« C & earthexplorer.usgs.gov

Featura Name

Country

Al v b
Feature Ciass Gl et * Kawasak)
Al V. Fujrsawa s ko ama

Featurs Type
Al v

m Crcle Predefmed Area

f egrie s | Cecma
ATy v p—

1. Lat: 35" 41"06" N, Lon: 13945 05" E

m Cloud Cover  Resull Options

Lzafiet | Tiles € Esnl — Source Esn bouted USDA USGS AEX GeoEye Getmapping, Acrognd, IGN, IGP LIPRLEGE: and e (35 User Community, ESRS

Search from: i to: |mmid
& The provided mapa are not for purchase or for download, it is to be used as a guide for reference and search purposes ondy.
Search months; 8% v

Data Sets »

DOl Privacy Policy | Legal | Accessibdity | Site Map | Co

S Department of the Intenor | DOI Inspector General | While House | Egov | No FearAct | FOIA
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Earth explore ¥/ ) spacesystems
® Select “SRTM 1 Arc-Second Global” data in “Data Sets” tab.

' oo i i %

<« & & earthexplorer.usgs.gov aQ % + 5 (o I @

performance. It your usel
d or you ara not ng an
e 10 refresh vaur st

* Aerial Imagery
+ AVHRR
+ CEOS Legacy

* Commarcial Satellites

Declassified ™

Mmba
Digitad Elevation *Kawasak)
.
Yokohama
Kyoto o:il - » Shi 2upka
Takist skl B * s
.

Hamanasu

Goh

"

Sacond Gaobal

Nor-Void Fillag

Clear All Selectod LNl | Tiles & Ewl — Sourtce E3n -aid, USDA USGE AEX. Go0Eye Gatmappng, Awearid, IGN IGP UPR-EGF and i 525 Ussr Community, ESRI

mm“w“M'ﬂmammnhb“w“lwhm“mmw.

DOl Privacy Policy | Legal | Accessibdity | Site Map | Ce

S Department of the Intenor | DOI Inspector General | While House | Egov | No FearAct | FOIA
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Earth explore @spacem‘fems

® You don’t need to set additional criteria.

' EE EarthExplorer X +

C @& earthexplorer.usgs.gov Q %« + 5 B O R @
a USGS

s

science for a changing workd

EarthExplorer

Search Crtena Data Sets m Resuks Search Criteria Summary (Snow Clear Search Criteria

3. Additional Criteria (Optional)

If you have more than one data sets selected, use the dropdown
10 selact tha addational critaria for each data st

Daia Sels
SRTM 1 Arc-Second Global v

Entity ID @
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Earth explore @spacesys‘tems

® The list of results is displayed in left side.

' EE EarthExplorer X +

<« C & earthexplorer.usgs.gov Q %« + 5 B O R @
a USGS

i

science for a changing workd

EarthExplorer

Search Critenia Date Sets  Adatonal Crtena Search Criteria Summary (Snhow Clear Search Criteria

4. Search Results

If you selected more than one data set to search, use the
dropdown 1o sea the saarch results for each speciiic data set

Show Result Controls

Data Ser
SRTM 1 Arc-Second Global

1wv
Displaying 1 -1 0of 1
Entity ID: SRTMINISE 129V

Publication Date: 2014.00.23 00 00 00-05
Resolution: 1. ARC
Coordinates: 35 130

‘ oo - M e

/-

1v
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Earth explore @spacesysfems

® In order to check metadata, click thumbnail image in the list.

' EE EarthExplorer X +

< C & earthexplorer.usgs.gov Q %« + & B O R @ :

Siandard Browsa

Dota Set Attribute Attribute Value

Entity ID SRIMINISETIVI

Acqusiton Dale 2000-02-11 00 00:00-08

Pubhcation Date 2014-00-23 00O

Resoluton 1-ARC

»
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Earth explore @spacamfems

® In order to check image coverage, click “Show Footprint” icon.

' EE EarthExplorer X +

- C & earthexplorer.usgs.gov Qa « + & B Q0 » @
a USGS

=

science for a changing workd

EarthExplorer

Search Critena~ Data Sets  Adabonal Cntera m Search Criteria Summary (Snow Clear Search Criteria

4. Search Results

If you selected more than one data set to search, use the
dropdown 1o sea the saarch results for each speciiic data set

Show Result Controls
Data Ser
SRTM 1 Arc-Second Global

1wv
Displaying 1 -1 0of 1
Entity 10: SRTMINISE 139V3
Publication Date; 201406023 00 00 00-05
Resolution: 1.ARC
Coordinates: 35 19

B"Q. /5 H0

1V
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Earth explore @spacem‘fems

® In order to check preview image, check “Show Brows Overlay” icon.

' EE EarthExplorer e+

C @& earthexplorer.usgs.gov Q %« + 5 B O R @
a USGS

s

science for a changing workd

EarthExplorer

Search Critena Data Sets Adabonal Cntena Search Criteria Summary (Snow Clear Search Criteria

4. Search Results

If you selected more than one data set to search, use the

fukaya
dropdown 1o sea the saarch results for each speciiic data set AL

Show Result Controls
Data Ser
SRTM 1 Arc-Second Global

1wv
Displaying 1 -1 0of 1
Entity 10: SRTMINISE 139V

Publication Date: 20140823 00 00 00-05
Resolution: 1.ARC
Coordinates: 35 19

____ L5 RPN

1V
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Earth explore

® In order to download data, click “Download Options” icon.
® And click download button of “GeoTiff 1 Arc-Second (xx.xx MiB)".

' EE EarthExplorer X +

< C @& earthexplorer.usgs.gov

O I R
! . ‘
BIL 1 Arc-second (8.43 MIB)

QTED 1 Arcsecond (24.78 MIB)

GeoTIFF 1JAarc-second (24.76 MIB)
| S
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Earth explore

® Move downloaded file to SRTM folder.

Downloads

Share View

File Home

tra large icons &= Large icons Group by =
B Preview pane @l Extra large icons = Large icons P by

£5 Medlum lcons 853 Small icons v l Add columns = ¥!| File name extensions
| Navigation Detai < n Sort Hide selacted
[ B Details pane List = Detalls 5 RN Size all columns to fit Hidden items Y
p Y em
\ Panes Layout Current view Show/Mhide
& - 4 ¥ > ThisPC > Downloads v O canrch Downloads
’ ¥ Dowinloads * O Name Date modified
Data
Today (1}
Raster
¥ n35_e139_1arc_v3.tif 1 020 3:59 AM
ASTER
Yesterday (4}
Landsat8
Datﬂ 1 2Q /2 5:51 AN
Sentinell : R
work 1 020 3;24 PM
Sentinel2
@] 721900-x64 exe 1 020 10:54 AM
SRTM Q@ QGIS-OSGeo4W-3.16.1-1-Setup-x86_64.exe 11/29/2020 918 Al
Vector
work
D Music
& Pictures
. Videos

<. Windows (C))
cChikhae AMVATY AC 1 ANV I

5 items

[¥! iem check boxes

Options

{!
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Earth explore
® DEM data is here.

R B = CAUsers\ERS-307\Downloads\Data\Raster\SRTM

Group by * (W item check boxes

v! File name extensions

File Home Share View
Extra large icons &= Large icons
I B Preview pane a g Sl
£5 Medlum lcons 853 Small icons 1 Add columns *
| Sont Hide selected  Options
\ | Hidden items ams -

Navigation N : X
) B Details pane List Detalls 5 s all coltaie i it

pane * by *

Layout Current view Show/Mhide

Panes

— + » This PC » Downloads » Data » Raster > SRTM

v ¥ Downloads *n35-e139_1arc_v3.tif
v Data
v Raster
ASTER
Landsat8
Sentinell
Sentinel2
SRTM
Vector
work
D Music
& Pictures
> . Videos
. Windows (C)

cChibha AVATI AC A ANV T

T

1 item

12020 Japan Space Systems
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Copernicus Open Access Hub @spamymm

® Search copernicus open access hub.

' New Tab X + : [
C G Search Google or type a URL w + B H O 0O N @ :

Bookmarks

Gmall Images : @

{=

Z Customize
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Copernicus Open Access Hub @spamystems

® Open link of “Copernicus Open Access Hub”.

' G SRS REAND "5‘599'5 : %

<« & @ google.com/search?q=copernicus+data+hub&oq=copernicus+data+hub&ags=chrome.69i57j0j0i22i3... ¥ + B . ¢ (9 @ :

Go g|e copernicus data hub X 3 Q
Q Al E News [EImages ¢ Shopping [ Videos  : More Settings  Tools

About 679,000 results (0.39 seconds)

.copernicus.eu ~

Copernicus Open Access Hub
Th i tously known as Sentinels Scientific Data Hub)
provides complete, free and open access to Sentinel-1, Sentinei-2, ...

You've visited this page many times. Last visit: 11/9/20
Scihub Copernicus Copernicus Sentinels POD ...
Copernicus Open Access Hub. + - Copernicus Sentinels POD Data
7. Open Street: { Data ... Hub. No products found ...
Sentinel-5P Data Offer Sentinel-5P Pre-Operations ...
The Open Access Hub provides Sentinel-5P Pre-Operations Data
complete, free and open access .. Hub, + =, ¢, i. Open Street ...

The Copernicus Open Access ...
Copernicus Sentinel-1A was

ot imilobln e VS Alas im b -
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Copernicus Open Access Hub
® Open link of “Open hub”.

' 3 Open Access Hub

« C @& scihub.copernicus.eu a %« + & H OO 0 -

ESA Cookie Policy. Thn wrdsdy uses tambies to track wuts, no pessana

By cunnmnumsg 1 4 he site e 1w Jgrevndg I o ¢ of tankies |

C i pe Coper ;.if Opgnvﬁcces‘ Hub Gosa [ i

— 4l

Welcome to the Copernicus Open Access Hub

The Copernicus Open Access Mub [pravicusly known as Sentineis Stientific Data Hub) provides complete, free and open access to
Sentinel-1, Senunel-2, Santinel-3 and Sentnel-5° user products, starting from the In-Orbit Commissioning Review (IOCR).

, i - D 32374
Sentinel Data are also available via the (opernicus Data and Irformation Access Services [OIAS] through several platforms '

prod. published In the last 24h

Please visit gur User Guice for gewing started with the Data Hub Interface. Discover how to use the APIs and
create scripts for actomane search and download of Sentinels’ data

Latest update: s22 the saction on Long Term Aschive for the upgrade of the interfaces for access w offiine data.

.!‘ 231,212

downloads In the last 24h

- o~
‘;:t"* S Reports
‘,,‘ 23 ¢ '0 o eports
AL TS
S¥e w2

Upen he NTh 5-5P PIEAOPF. POD Hub

O
£} DHUS Open Soures Portal

For further details or requests of support please send an e*mail to sosupport@copermicus 254 int
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Copernicus Open Access Hub ) spacesystems

® Click “Login” button and “Sing in” button to create new account.

| = - a n Please login to access our
— 7 T P i Services
lrwinnd - Y
L
L d

o
o it {
9 s
Faros dmmes
i
e * .
- LOGIN
"
[ p |
> < Sign up Forgot passwora?
o ’ ! ' r
oy » e ) T o » b ——— R—
. Lienma v Atheenie” 2 - hes o e % Worehrn
i ’ 2 2l -
' - e <
e * =
Tha Bar "
0 el a
°
B
° [ Kust o " . © .
E
: smans
@
3 Sarp R
©
o < ™ -
e of % .
« o
' [} . s o
.‘ -
R w 1
© e > b A
e - \
v " e
= a
o ~ Maite Gt a
Ll g Byrie o
o .
e .
v ; e a
. ¥ . .
., - B =g
.
Lawill
\ : ®
Ld
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Copernicus Open Access Hub

® Enter username, new password, and so on.

' e https.//schub.copernicus eu/d! X +
e

C & scihub.copernicus.eu/dhus/#/self-registration o Q Y -

eSa opemicus Copernicus Open Access Hub

@spacasysfems

Register new account

Sentinel data access is free and open to ail

-
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Copernicus Open Access Hub ) spacesystems

® After creating new account, sign in copernicus open access hub.

Login button

- 4 - >
| = - a n Please login to access our
— 7 T P i Services
lrwinnd - Y
L
L d
- )

° ~
. Dy ¢ &
9 s
Faros dmmes
-------- o)
i
e * .
- LOGIN
"
> 1
[
> Sign up Forgot passwora?
- —
) peree Lihuanie ® ety e b Rt Fa
a 2 ' w palen e <
' - e <
b * - °
o o
Tha Bar "
0 el a
°
B
° [ Kust o " . © .
E
# smans
@
y Sark R
©
o < ; ™ -
o ot A :
- Y :
' [} . s o
[
B ' i
2 o “ I WA
e " - - A
v " e
- a
o Maite Gt 3
- '
Ll g Syrie o
o e .
v 5 e a
. ¥ » .
., - 5 . =e
Lawill
\ ‘ ®
Ld
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Copernicus Open Access Hub - Sentinel-1

® Set sensing period you want to download data.

' @ htps//schub.copernicus eu/dh. X +
< C

eSa opemicus

& scihub.copernicus.eu/dhus/#/home

@spacesysfems

‘ Copermicus Open Access Hub
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Copernicus Open Access Hub - Sentinel-1

® Select mission as Sentinel-1.
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Copernicus Open Access Hub - Sentinel-1

@spacesysfems

® Select product type and sensor mode depend on your purpose.

> Here, select SLC as product type and IW as sensor type.

' @ htps//schub.copernicus eu/dh. X +
e

C & scihub.copernicus.eu/dhus/#/home

o esa

OPEMICUS
=] *

— - -
E w a
o "= ~ Ty .
B
; x 2 ; °
A Advanced Search e = L
°
dav o L)
e o  dEET .Mt ‘s
° o
- ° -
e gus
v ~ oy o? u
Normay 4 s 5 e
- = o
& Swaden =
4 L4
L $ L]
L ' “g
= = Cody
s 9, P ' N
Aaily Y e
) | pencd > .2
" e i S . j_ .
& - b |t d
5 4 °* et
.Y. ~ .l CCCCC Y ﬂ'
@ Mission: Sentinel-1 TReBarner1anas Petand ° F 9
4 ! tmany - - o : e
Balgium =
atedil 1 r & - .
! - g Utraine
% . wakin ) °
v B
: F > & Austrie  Hungery Naldw o 2
Pola »: o
'\ Ram
03] . Sl i ~Craal) c ",
e Sarpia » »
[ N LY —r ’
‘ v ! o v
@ it N { s o N i - i °
B = of Kasovs 1 & .
- Gasr gia 2
[ I ) s ’ el € . wAfroveetas
] . ' d @ Kz orter ot w
(=] Mission: Sentinel.2 » v o
| : i 5 Turkey - " L
o, oo o 4 e
- Whnnass o L .
a
tedit 1 et T : L mane S T ° "
/) '
N v " Tani e : . "
e L = Sl Ay
| from | 10T ; o, ° ® "
l - N L ® e .
v ks .
- awill .
How e 1
; % . 2 1 talt
‘ Seeni Arabis 2 ! A .‘“ )

“Event” in month, year 76

(12020 Japan Space Systems



® On navigation mode, move map to the target area.
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Copernicus Open Access Hub - Sentinel-1

® On area mode, select area by mouse on the map.
® Click search icon.
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thub.copernicus.¢
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Copernicus Open Access Hub - Sentinel-1 ) spacesystems

® In order to check metadata, click “View Product Details” icon.
® In order to download data, click “Download Product” icon.

S1B_IW_SLC__1SDV_20201123T084141_20201123T084208 024390 02E611 3... &

Downioad URL: https//scihub.copemicus. eu/dhus/odata/1/Products('25282fd3-eb14-47e6-
Mission: Sentinel-1 Instrument. SAR-C Sensing Date: 2020-11-23T08:41:41.498Z Size: 7.

1 View Product Download
Details Product
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Copernicus Open Access Hub - Sentinel-1

® Move downloaded file to Sentinell folder.
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Copernicus Open Access Hub - Sentinel-1

® Extract zip file here.
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Manage
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Copernicus Open Access Hub — Sentinel-2 /e

® Set sensing period you want to download data.
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Copernicus Open Access Hub — Sentinel-2 /e

® Select mission as Sentinel-2.
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Copernicus Open Access Hub — Sentinel-2 /e

® Select product type and cloud cover % depend on your purpose.
> Here, select S2MSI2A as product type and [0 TO 1] as cloud cover %.
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® On navigation mode, move map to the target area.
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® On area mode, select area by mouse on the map.
® Click search icon.
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® The list of results is displayed in left side.
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Copernicus Open Access Hub — Sentinel-2 /e

® In order to check metadata, click “View Product Details” icon.
® In order to download data, click “Download Product” icon.

5l s28_msiL2A 20201113T012919_NO0214_R074_T54SVE_20201113T035452 =

Downioad URL; https//scihub.copernicus. eu/dhus/odataN 1/Products{’c72de27e-ec10-4bdt
Mission: Sentinel-2 Instrument: MSI Sensing Date: 2020-11-13701;29:19.024Z Size: 952.

S v 3
T HE
View Product Download
Details Product
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Copernicus Open Access Hub - Sentinel-2

® Move downloaded file to Sentinel2 folder.

Compressed Folder Tools (7]

Home Share View

i ~AF ons Group by * [¥! iem check boxes
B Preview pane @l Extra large icons = Large icons [ HOUP Y

- v = ' :
sa Medlum lcons 252 Small icons - l Add columns = V| File name extensions

| Navigation "3 Details : . sort Hide selected  Options
| ane List = Do c | an ite
\ pane * tails by * size all columns to fit Hidden items tems -

nes Layout Current view Show/Mhide
+ ¥ > ThisPC > Downloads v 9] 0 Search Downloads

’ ¥ Downloads A [ Name Date modified Type
Data
Today (5)
Raster o
Data 11/29/2020 951 AM File foide

ASTER work 11/29/2020 3:24 PM File foldd

Landsatd 721900-x64 exe
Sentinell (G} QGIS-05GeodW-2.16.1-1-Setup-x86_64.exe
Sentinel2 11 S2B_MSIL2A_20201113T012919 NO214_RO74 T

ZIP JrAo
Vector
GADM
work
S2B_MSIL2A_20201113T012919_NO214 R
D Music
= Pictures

B videos

® WWiemdAdeane (A

5 items 1 |lcm srlcclcd 9)2 MB -
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— Sentinel-2

Copernicus Open Access Hub

® Extract zip file here.

Extract

CAUsers\ERS- T\ Downloads)

Home Share View

—

= Mediven lons -_; Small }ons . . A columns ~ W Fie name extensions
Navigaton 7§ Details pane Sort Hide selected  Optians
. = List Detaity v Size b 10 & cir
pane = s by - wre all cokimns 1o Hiadon Iterms tems =
Panes Layout Current view Show/tude
« Open Raster » Sentineld » v 0 earch Sentinel

¥ Preview pane

$ bor 6 Share with Skype

B Extra large xons &= Large lcans

Campressed Folder Jools

Gioup by =

ster\Sentinel2

| ltem check boses

Mamé Dlate oo -
D € share with Skype R B = CA\Users\ERS-307\Downloads\Data\RastenSentinel2
I2ip b Open archive Flle Hame Share View @
CRC SHA S
Open archive B previe W8 £xira large kons B2 Large lcans Group by * ¥ ltem check boses
. GeoSetlev ) Ext(an rm I TEVIEW [ 2 - g
4 = Medium Lons vl loons v 1 A coluns = ! File name extansions
Navigation B Detalls nane st Hecke selocted  Optians
L-‘ e M :a.;:;: -.r e oy List Details P n‘_,, < Seze all codumis 1o Higden lema ‘["‘"N. ; * 4
P R Le B U 2 Extract te “528_ MSIL2A 202011 = o ok vl Show/Nde
anes yout Current view show/Mde
Open with > Test archive
- + » This PC » Downloads » Data » Raster » Sentineld » v (5] rch Sentiny
Give access to > Add to archwve
Restore previous versions Compress and email § Downlosds 2 Name Date modified ypr
w
Add to "S28_MSIL2A_20201113 Data =
b Mu Send 10 > 3 B 528 _MSIL2A_202071113T012919.NO21..,  1)/1020 20 PM File foide
v o 2
i SOMPNEE 10 SR Siodal) e Raster S28 MSILZA 20201113T012918 NO21..  11/29/2020 4 18 PM 219 Fr4 )L
&= Pict Cut Add to *528_MSIL2A_20201113 ASTER
Wvid  Copy Compress to *528_MSIL2A 202 Larddisth
& Wir Create shortcut Sentinel]
chi
1 item ere Sentinel2
Vector
GADM
work
,\ Music
~ Pictures
. Videos
<. Windows [C)
v < ?
Chibn AVITY 32 Y v /9N
-~

< Items

1 item selected
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S2B_MSIL2A_20201113T012919_N02

AUX_DATA

DATASTRIP

GRANULE

L2A T54SVE_AD19262 202011137
AUX_DATA
IMG_DATA

R10m
R20m
R60mM

M1 NATA

® Satellite images are extracted under IMG_DATA folder.
> Different spatial resolution is saved in R10m, R20m and R60m.

C\Users\ERS-307\Downloads\Data\Raster\Sentinel2\S28_MSIL2A_20201113T012919_N0214_R0O74_T54

Home Share View

B Preview pane B8 Extra large icons &= Large icons Group by ~

S8 Medium icons 255 Small icons v I Add columns =
- - sSon

¥ Details pane List b:-;" T, Size all columns to fit
Panes current view

T « L2A_TS4SVE_AD19262_20201113T013516 > IMG_DATA » R10m

ASTER Name

Landsat8

= ¥ T54SVE_202011137012919_AOT_10m .
Sentinel1 ¥e T54SVE_202011137012919_802_10m jp2
Sentinel2 #= T545VE_20201113T012919_B03_10m jp2

¥z T54SVE_202011137012919_804_10m jp2
¥ T54SVE_20201113T012919_B08_10m jp2
#= T54SVE_20201113T012919_TCI_10m jp2
¥z T54SVE_20201113T012919_WVP_10mj...
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GADM R

® Search GADM.

' New Tab X + : 0
C G Search Google or type a URL w + B H O 0O N @ :

Bookmarks

Gmall Images : @

Google

© GADM

{=

Z Customize
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® Open link of GADM.,

@spacasysfems

' G o Gl'\}cgic S %

< C & google.com/search?q=GADM&ioq=GADM&aqgs=chrome.0.69i59j0i10j0:20i263]013)0i10j0.37384/0}158s..

Go gle GADM X

QA B mages [ Videos [E News Q Maps i More Settings

About 2,220,000 resuits {0.33 seconds)

and data. GADM provides maps and spatial data for all countries and their sub-
divisions. You can browse our maps or download the data to make ..

Country Download GADM data
Download GADM data. Current
version (3.6). These are very ..

Download GADM data (version
3.6). Country, Afghanistan, Akrotiri

Data Maps
GADM data. The current version is Browse maps by country. (GADM

3.6. It delimits 386,735 ... version 2.8). Afghanistan ...

More results from gadm.org »

en.wikipedia.org » wiki » GADM ~

GADM

@ gadm.org

GADM, the Database of Glc
Is @ high-resolution databas:
areas, with a goal of "all coL
time period." The database

formats, including shapefile:
common GIS applications. V
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® Open link of Data.

C & gadm.org

GADM maps and data

GADM provides maps and spatial data for all countries and their
sub-divisions. You can browse our maps or downioad the tata

to make your own maps

12020 Japan Space Systems
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GADM R

® Open link of country.

« C & gadm.org/datahtml * + B 0 O 0O N G :

GADM data

The current version is 3.6. |L2etmms386,735 administrative areas. Version 4 will be released in April 2020. You can
download the spatial data w

Downloading by country is the recommended approach. You can also download the data for the entire world.

Read about the changes in our change log and learn more about these data on our meta-data page.
Older versions can be donloaded here.

The data are freely available For academic use and other non-commercial use. Redistribution, or commercial use is
not allowed without prior permission.

© 2018 GADM - license
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GADM R

® Select country.

- C & gadm.org/download country v3.html

Download GADM data (version 3.6)

Country

v

1

Select
country

© 2018 CADM - license

Data hosting provided by the Center for Spatial Sciences at the University of California, Davis.
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® C(Click “Geopackage” to start download.

- C @& gadm.org/download country v3.html “ + B H O O N 0 :

Download GADM data (version 3.6)

Country
Japan v

Geopackage

i GeoPackage
R (sp): level-0, le\

R (sF): level-0, level1, level2
KMZ: tevel-0, levell, level2
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® Move downloaded file to GADM folder.

View

Home Share

B Preview pane

| Navigation "l Details pane List
\ pane *

Panes

&« « 4 ¥ » ThisPC » Downloads »

’ ¥ Dowinloads
Data
Raster
ASTER
Landsat8
Sentinell
Sentinel2
Vector
GADM
work
gadm36_JPN_gpkg.zip
D Music
= Pictures

B videos

® WWiemdAdeane (A

5 items 1 item selected 11.4 M8

sa Medlum lcons

Downloads

Compeessed Folder Tools

@l Extra large icons = Large icons [ Group by *

v -
22s Small icons X 1 Add columns =

Sort

= Details s 7 Size all columns to fit

by =

Current view

Name

Today (5)
Data
work
[ 721900-x64 exe
(21t gadm36_JPN_gpkg.zip

(3} QGIS-05GeodW-3.16.1-1-Setup-x86_64.exe

[¥! iem check boxes

v! File name extensions

r
U
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® Extract zip file to “gadm36_JPN_gpkg¥”.

Extract

CAUsers\ERS- T\ Downloads\Dat

Hame Share View

¥ Preview pane

—

Navigaton

pane -

& Moediven ons

B Details pane List

“ - open
$ bo & Share with Skyps
o € share with Skype

?-lng

CRC SHA
GeoSetter
L‘_? Shase

=ty ase
Open with

Give access 10
| Restore previous versions

w
g Sendto
S Cut

3 Mu Copy

& Pic Create shortout

= oid

Delete

1 item

B Extra large xons &= Large lcans

Campressed folder Jools

Gioup by = ! ltem check bosss
5 Small ioons - A calumns = ¥ Fie nama extensions
= - Sort Hide selected  Optians
Detaiby by - Size all cokimns 1o 0t Higdon lterms Hisine =
ayout current view Show/tude
‘ Vector » GADM v 9] earch GADM
¢
Mame — -
4 . AR CAUsers\ERS-307M\Downloads\Data\Vecto\GADM
Open archive Flle Hame Share Iew Q
Open archive
: l B Proview par B cxtra larae kons &= Large lcans Group by - ¥ ltem check bowes
X review pan <
Extract files .

Extract Here
Extract to “gadm36_JPN_gokg\|

Test archive

Add to archive

Compress and email

Add 1o "gadm3s_IPN_gpkg 2.7
Compress to *gadm3c_JPN_gpl
Add to "gadm3&_IPN_gpkg 2.7
Comperess to “gadm3s_JPN_ap

S5 Medium Kons 5 Small icons » NAME EXPNslens

ede slected

=l 1 A coluinns = v il
Navigation B petalls pane Dpticing
- U List Getails v Size all columins 1o 9t Hidden ilema

pane * items .

anes yout Current view Show/Mde

- v 4 » ThisPC » Downloads > Data » Vector » GADM » v 0 rct

# Downlosds 2 ! Name Date modsfied Type

Data

M gadm36_JPN_gpkg 11/29/2000 2:55 P Fle foicer

Raster gadm36 JPN_gpkanp 117292020 118 PM ZIp JrAlh

ASTER
Landsatd
Sentinell
Sentinel2
Vector
GADM
work
gadm35_IPN_gpkg zip
S1B_IW _SLC_ 15DV _20201123T083141 24
J Music

= Pictures
<
B dnas o >

2 items 1 item selected -~
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® Administrative border file is extracted.

CAUsers\ERS-307\Downloads\Data\Vector\GADM\gadm36_JPN_gpkg

File Home Share

l B Preview pane

| Navigation
\ pane =

View
@l Extra large icons = Large icons Group by *

v
sa Medlum lcons 252 Small icons -

= Detalls ¥

11 Add columns =
B Details pane soft

by =

List

Panes Layout Current view

« * Downloads » Data » Vector > GADM > gadm36_JPN_gpkg

¥ Downloads A M

Name
Data gadm36_JPN.gpkg

Raster B license.txt

ASTER
Landsat8
Sentinell
Sentinel2
Vector
GADM
gadm36_JPN_gpkg
gadm36_JPN_gpkg.zip
work
gadm36_JPN_gpkg.zip
S1B_IW_SLC__1SDV_202011237084141_2¢

LY P > 8

2 items

7 Size all columns to fit

¥ Hem check

boxes

v! File name extensions

Hidden items

Show/Mhide

Options

e »

jJadm36_IPN_gpkg
ype
PKG File
*xt
>
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